
CHÖÔNG I.
CAØI ÑAËT MAPINFO VAØ ÑIEÀU CHÆNH CAÙC THIEÁT LAÄP
MAËC ÑÒNH CUÛA MAPINFO

I.1. CAØI ÑAËT MAPINFO

I.1.1. Caøi ñaët MapInfo

Phaàn naøy seõ trình baøy caùch caøi ñaët MapInfo phieân baûn 6.0.

Yeâu caàu heä thoáng: ñeå caøi ñaët ñöôïc MapInfo 6.0, maùy tính phaûi chaïy moät trong caùc
heä ñieàu haønh sau: Window 95, Window 98, Window NT 4.0 hay Window 2000.
MapInfo 6.0 cuõng chaïy toát treân Window XP. Caáu hình toái thieåu ñeå moät maùy tính coù theå
chaïy ñöôïc MapInfo 6.0 laø maùy 486 PC vaø 16M RAM boä nhôù.
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Hình I.1. Maøn hình khôûi ñoäng khi caøi ñaët MapInfo.

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com


Tröôùc tieân ta phaûi cheùp soá Serial Number cuûa phaàn meàm ñeå naïp vaøo trong quaù
trình caøi ñaët. Thöïc hieän caùc böôùc sau ñeå tieán haønh caøi ñaët:

- Ñöa ñóa CD MapInfo vaøo oå CD treân maùy tính.

- Maøn hình caøi ñaët MapInfo coù teân laø MapInfo CD Browser seõ xuaát hieän (hình I.1). Neáu
maøn hình naøy khoâng xuaát hieän, haõy môû Window Explorer vaø tìm treân ñóa CD taäp tin
Setup.exe, choïn taäp tin naøy roài nhaán phím <Enter> ñeå khôûi ñoäng chöông trình caøi
ñaët.

- Nhaép chuoät vaøo Intall Products, maøn hình chuyeån sang trang Intall Products.

- Nhaép chuoät choïn MapInfo Professional. Hoäp thoaïi Welcome (Chaøo möøng) seõ hieän
ra.

- Nhaép chuoät choïn Next. Hoäp thoaïi Software License Agreement (Thoaû thuaän veà baûn
quyeàn phaàn meàm) hieän ra.

- Choïn Next. Hoäp thoaïi User Information (thoâng tin ngöôøi duøng) hieän ra (hình I.2).

- Goõ teân ngöôøi duøng vaøo oâ Name, goõ teân coâng ty vaøo oâ Company, goõ soá Serial Number
vaøo oâ Serial.

- Choïn Next. Maøn hình khaúng ñònh caùc thoâng tin maø ta ñaõ ñaêng kyù hieän ra (hình I.3).

Neáu haøi loøng vôùi nhöõng gì ñaõ naïp, choïn Yes ñeå tieáp tuïc, neáu khoâng choïn No ñeå
quay laïi maøn hình tröôùc ñoù vaø chænh söûa caùc thoâng tin.

- Choïn Next. Hoäp thoaïi Choose Destination Location (Choïn Thö muïc ñeå caøi ñaët) hieän
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Hình I.2. Hoäp thoaïi User Information (Thoâng tin ngöôøi duøng).
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ra (hình I.4). Theo maëc ñònh
trong heä ñieàu haønh
Window, MapInfo seõ töï
ñoäng taïo moät thö muïc coù
teân laø MapInfo Professional
trong thö muïc Program
Files treân oå ñóa cuûa heä ñieàu
haønh vaø caøi daët chöông
trình. Thoâng thöôøng thì ta
khoâng caàn thay ñoåi gì caû.
Tuy nhieân neáu muoán caøi ñaët
MapInfo leân moät thö muïc
khaùc treân oå cöùng thì nhaép
chuoät choïn nuùt Browse ñeå
môû hoäp thoaïi Choose
Directory ra vaø choïn thö
muïc cuõng nhö oå ñóa muoán
caøi ñaët.

- Choïn Next. Hoäp thoaïi Setup Type (choïn Kieåu caøi ñaët) môû ra (hình I.5). Trong phaàn
Workstation Configuration ta coù hai tuyø choïn. Tuyø choïn maëc ñònh Standalone
Workstation (maùy traïm rieâng leû) laø cheá ñoä caøi ñaët MapInfo cho moät maùy tính duy
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Hình I.3. Thoâng baùo kieåm tra laïi ñaêng kyù caøi ñaët.

Hình I.4. Hoäp thoaïi Choose Destination Location - Choïn thö muïc caøi ñaët.
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nhaát. Tuyø choïn Network Server laø caøi ñaët MapInfo vaøo maùy phuïc vuï treân maïng. Giaû
söû ta choïn Standalone Workstation (chæ caøi treân moät maùy).

- Trong oâ troáng phía döôùi coù hai tuyø choïn laø Custom vaø Typical. Neáu choïn Typical thì
MapInfo seõ töï ñoäng tieán haønh caøi ñaët nhöõng thaønh phaàn sau: chöông trình chính

MapInfo, Online Help, Tools, DAO Support, Universal Translator, ArcLink vaø
Crystal Report. Neáu choïn Custom thì ta coù theå choïn caøi ñaët nhöõng thaønh phaàn khaùc
nhau cuûa MapInfo theo yù muoán. Neáu choïn caøi ñaët theo kieåu Typical maø coù moät
thoâng baùo hieän ra noùi raèng khoâng coù ñuû khoâng gian treân ñóa cöùng ñeå caøi ñaët thì haõy
choïn nuùt Back ñeå quay laïi vaø choïn Custom. Neáu ta choïn Typical thì trình caøi ñaët seõ
chuyeån ngay sang hình I.7. Giaû söû ta choïn Custom.

- Choïn Next. Hoäp thoaïi Select Components (choïn caùc thaønh phaàn caøi ñaët) môû ra (hình
I.6). Trong caùc thaønh phaàn caøi ñaët cuûa MapInfo goàm coù 4 muïc chính:
+ Program Files: chöông trình chính cuûa MapInfo.
+ Online Help: phaàn giuùp ñôõ tröïc tuyeán.
+ Tools: laø phaàn coù caùc coâng cuï khaùc nhau hoã trôï cho chöông trình chính. Neáu

choïn muïc naøy roài nhaép chuoät choïn nuùt Change ôû phía döôùi thì hoäp thoaïi Sub-
component (thaønh phaàn phuï) môû ra cho pheùp ta choïn caùc thaønh phaàn khaùc trong
nhoùm Tools. Trong nhoùm Tools coù hai tuyø choïn nhoû laø MapInfo Utilities vaø
Seagate Crystal Report. MapInfo Utilities laø caùc thaønh phaàn nhaèm hoã trôï cho
chöông trình chính MapInfo. Seagate Crystal Report laø phaàn coù chöùc naêng taïo
baùo caùo Crystal nhaèm cung caáp thoâng tin veà döõ lieäu cuûa ta treân MapInfo. Choïn
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Hình I.5. Hoäp thoaïi Setup Type - Choïn kieåu caøi ñaët.
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caùc muïc caàn thieát roài choïn Continue ñeå quay laïi hoäp thoaïi Select Component.
+ Translators: ñaây laø phaàn neáu choïn caøi ñaët seõ coù chöùc naêng chuyeån ñoåi caùc

daïng taäp tin baûn ñoà soá khaùc nhau qua MapInfo vaø ngöôïc laïi. Neáu vaøo thaønh
phaàn phuï cuûa muïc naøy ta seõ thaáy coù moät soá muïc con khaùc. Phaàn Universal
Translator cho pheùp chuyeån ñoåi giöõa caùc baûn ñoà soá ñònh daïng MapInfo vaø ñònh
daïng khaùc. Hai tuyø choïn AG*Link vaø ArcLink cho pheùp dòch caùc taäp tin cuûa
MapInfo sang ArcInfo vaø ngöôïc laïi. Choïn caùc muïc caàn thieát xong choïn Continue
ñeå quay laïi hoäp thoaïi Select Component.

ÔÛ beân phaûi moãi muïc hieän leân dung löôïng caàn thieát ñeå caøi ñaët töøng thaønh phaàn ñoù.
ÔÛ phía döôùi coù doøng Space Required vaø beân phaûi hieän leân toång dung löôïng caàn thieát
ñeå caøi ñaët MapInfo. Doøng Space Available beân döôùi cho bieát coøn bao nhieâu khoaûng
troáng treân oå ñóa ta muoán caøi ñaët MapInfo. Caàn ñaûm baûo coù ñuû khoâng gian treân ñóa cöùng
cuûa maùy tính.

- Choïn xong caùc thaønh phaàn caøi ñaët nhaép chuoät choïn Next. Hoäp thoaïi Select Program
Folder (Choïn teân thö muïc chöông trình) (hình I.7) hieän ra.

- Ta coù theå ñaët teân cho thö muïc chöông trình MapInfo saép caøi ñaët, neáu muoán, baèng
caùch goõ teân thö muïc trong oâ Program Folder. Neáu khoâng trình caøi ñaët töï ñoäng ñaët
teân cho noù laø MapInfo.

- Laøm xong choïn Next. Hoäp thoaïi Start Copying Files môû ra (hình I.8). Hoäp thoaïi naøy
lieät keâ nhöõng thieát laäp cheá ñoä caøi ñaët ñaõ choïn trong caùc hoäp thoaïi tröôùc ñoù ñeå ta coù
theå kieåm tra laïi laàn cuoái. Caùc thoâng tin naøy naèm trong oâ Current Settings. Neáu caûm
thaáy öng yù thì choïn Next vaø trình caøi ñaët baét ñaàu cheùp caùc taäp tin chöông trình cuûa
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Hình I.6. Hoäp thoaïi Select Components - Choïn caùc thaønh phaàn ñeå caøi ñaët.
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MapInfo leân maùy tính.

Quaù trình caøi ñaët naøy coù
theå maát 5 - 10 phuùt tuyø theo
toác ñoä maùy tính hieän nay. Ña
phaàn toác ñoä maùy tính hieän
nay toái thieåu laø Pentium III
hoaëc toác ñoä töông ñöông vì
theá quaù trình caøi ñaët raát
nhanh. Sau khi caøi ñaët xong
MapInfo hieän doøng thoâng baùo
quaù trình caøi ñaët thaønh coâng.

Sau khi caøi ñaët MapInfo
xong, trình caøi ñaët hieån thò
hoäp thoaïi hoûi ta muoán caøi ñaët
tieáp phaàn ODBC, ORacle 8i,
DAO (MS Access) hay
khoâng. Ñaây laø phaàn hoã trôï lieân
keát vôùi cô sôû döõ lieäu ngoaøi
MapInfo. Ta phaûi caøi ñaët phaàn
naøy neáu muoán môû baûng MS Access tröïc tieáp trong MapInfo. Neáu muoán ta coù theå choïn
caøi ñaët tieáp. Neáu khoâng ta coù theå choïn No vaø keát thuùc caøi ñaët. Tuy nhieân neáu sau naøy
muoán caøi ñaët phaàn naøy ta chæ caàn ñöa ñóa CD MapInfo vaøo oå CD treân maùy vaø choïn caøi
ñaët rieâng phaàn naøy (muïc DBMS Support) töø maøn hình khôûi ñoäng caøi ñaët MapInfo luùc
ñaàu.

Trong suoát quaù trình caøi
ñaët treân, baát kyø luùc naøo ta
cuõng coù theå nhaép chuoät choïn
nuùt Cancel ñeå huyû quaù trình
caøi ñaët. Khi choïn nuùt naøy,
MapInfo hieån thò moät thoâng
baùo yeâu caàu khaúng ñònh laïi
laàn nöõa vieäc huyû caøi ñaët. Neáu
thöïc söï muoán huyû caøi ñaët,
choïn Exit Setup, neáu muoán
tieáp tuïc, choïn Resume. Treân
taát caû caùc hoäp thoaïi trong quaù
trình caøi ñaët ñeàu coù nuùt Back
cho pheùp quay laïi hoäp thoaïi
tröôùc ñoù ñeå ñieàu chænh laïi caùc
thoâng tin neáu caàn thieát.

Thöïc ra treân maøn hình caøi
ñaët MapInfo coù nhieàu noäi
dung caøi ñaët khaùc nöõa. tuy
nhieân ñeå traùnh cho taäp saùch
quaù daøy ñoàng thôøi nhöõng noäi
dung treân cuõng khoâng phaûi laø
muïc tieâu cuûa taøi lieäu naøy neân

6

Hình I.8. Hoäp thoaïi Start Copying File - chuaån bò
cheùp caùc taäp tin caøi ñaët vaøo maùy tính.

Hình I.7. Hoäp thoaïi Select Program Folder - ñaët
teân cho thö muïc caøi ñaët MapInfo.
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trình baøy veà caøi ñaët nhöõng phaàn ñoù khoâng ñöôïc ñeà caäp. Trong phaàn Intall Products ta
coøn coù caùc muïc caøi ñaët sau: DBMS Support (Hoã trôï lieân keát DBMS), Data (caùc taäp tin
MapInfo maãu ñeå thöïc taäp), MrSid Raster Handler (trình quaûn lyù aûnh soá MrSid), ECW
Raster Handler (Trình quaûn lyù aûnh soá ECW), MetaData Browser (Trình duyeät
MetaData), GPS (caøi daët öùng duïng maùy ñònh vò ñeå hieån thò toaï ñoä töø maùy ñònh vò tröïc
tieáp leân MapInfo) vaø phaàn taøi lieäu tham khaûo tröïc tuyeán.

I.1.2. Khôûi ñoäng MapInfo ñeå söû duïng

Sau khi caøi ñaët xong MapInfo,
heä ñieàu haønh seõ taïo ra moät bieåu
töôïng treân thanh chöông trình. Ñeå
khôûi ñoäng MapInfo, nhaép chuoät
choïn nuùt START cuûa heä ñieàu haønh,
vaøo muïc Programs, choïn MapInfo
roài choïn MapInfo Professional 6.0.
Chöông trình MapInfo seõ ñöôïc khôûi
ñoäng.

Theo cheá ñoä maëc ñònh khi caøi
ñaët, luùc khôûi ñoäng MapInfo seõ hieän
ra hoäp thoaïi Quick Start (khôûi ñoäng
nhanh - hình I.9) cho pheùp choïn
nhanh moät soá noäi dung maø ta muoán
MapInfo thöïc hieän ngay:

- Restore Previous Session: phuïc hoài laïi phieân laøm vieäc tröôùc, töùc laø môû laïi nhöõng gì
maø ta ñang môû trong laàn söû duïng MapInfo tröôùc.

- Open Last Used Workspace: neáu tröôùc ñoù ta coù laøm vieäc treân moät taäp tin workspace
(khoâng gian laøm vieäc) thì tuyø choïn naøy cho pheùp vaøo ngay phieân laøm vieäc ñoù. Phía
döôùi tuyø choïn naøy hieän ra teân cuûa taäp tin workspace môû ra laàn tröôùc, ví duï
test.WOR.

- Open a Workspace: môû moät workspace ñaõ ñöôïc löu tröôùc ñaây.

- Open a Table: môû moät baûng cuûa MapInfo.

Ta coù theå taét hoäp
thoaïi khôûi ñoäng nhanh
naøy ñi neáu muoán. Xin
xem tieáp trong phaàn
sau.

Ñeå keát thuùc phieân
laøm vieäc vaø thoaùt khoûi
MapInfo ta choïn menu
File ôû goùc treân cuøng
beân traùi cuûa maøn hình
MapInfo vaø choïn muïc
Exit ôû döôùi cuøng hoaëc
coù theå söû duïng toå hôïp
phím <Alt> + <F4> ñeå
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Hình I.9. Hoäp thoaïi Quick Start -
Khôûi ñoäng nhanh.

Hình I.10. Hoäp thoaïi Save Modified Table Data.
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thoaùt khoûi MapInfo gioáng nhö taét baát kyø moät öùng duïng naøo khaùc treân heä ñieàu haønh
Window. Khi thoaùt khoûi MapInfo, neáu trong quaù trình laøm vieäc ta coù thöïc hieän nhöõng
thay ñoåi gì ñoù treân baûn ñoà hay trong baûng döõ lieäu cuûa caùc baûn ñoà, MapInfo seõ hieän ra
hoäp thoaïi thoâng baùo nhaéc ta löu laïi nhöõng thay ñoåi (hình I.10). Neáu muoán löu nhöõng
thay ñoåi cuûa baûng ñang hieån thò trong hoäp thoaïi ta nhaán nuùt Save. Neáu coù nhieàu baûng
ñöôïc chænh söûa vaø muoán löu nhöõng thay ñoåi cuûa taát caû caùc baûng ta nhaán nuùt Save All.
Neáu khoâng muoán löu nhöõng thay ñoåi trong baûng ñang hieån thò treân hoäp thoaïi ta nhaán
Discard. Neáu khoâng muoán löu nhöõng thay ñoåi treân taát caû caùc baûng ta nhaán nuùt Discard
All.

I.2. ÑIEÀU CHÆNH CAÙC THIEÁT LAÄP CUÛA MAPINFO

Khi caøi ñaët vaø söû duïng MapInfo, phaàn meàm
naøy coù moät soá thieát laäp maëc ñònh. Tuyø theo nhu
caàu söû duïng, ngöôøi duøng coù theå thay ñoåi caùc thieát
laäp maëc ñònh naøy sao cho phuø hôïp vôùi mình. Ñieàu
chænh caùc thieát laäp naøy naèm trong menu Options >
Preferences.

Ñeå ñieàu chænh caùc thieát laäp cuûa MapInfo, töø
menu chính choïn Options > Preferences. Hoäp
thoaïi Preferences (hình I.11) môû ra. Hoäp thoaïi naøy
coù nhieàu muïc khaùc nhau. Nhaép chuoät vaøo töøng
nuùt seõ môû ra hoäp thoaïi thieát laäp cuûa phaàn ñoù. Ta
seõ xem xeùt töøng muïc moät.

I.2.1. System Settings

Nhaép chuoät choïn nuùt naøy ñeå vaøo hoäp thoaïi
ñieàu chænh caùc thieát laäp chính aûnh höôûng ñeán caùch
thöùc MapInfo töông taùc vôùi maùy tính. Hoäp thoaïi
System Settings (hình I.12) bao goàm caùc phaàn:

- Copy to Clipboard: thieát laäp caùc thaønh phaàn coù
theå chöùa ñöôïc vaøo boä nhôù taïm. Coù 3 thaønh
phaàn laø Text (vaên baûn), Bitmap (aûnh soá) vaø
Metafile (taäp tin ñònh daïng .wmf). ÔÛ cheá ñoä maëc
ñònh 3 tuyø choïn naøy ñeàu ñöôïc baät leân.

- Color Defaults: thieát laäp cheá ñoä maøu. Tuyø choïn
maëc ñònh laø Monitor Setting - töùc laø cheá ñoä maøu theo maøn hình. Hai tuøy choïn kia laø
Black and White (cheá ñoä Traéng Ñen) vaø Color (theo cheá ñoä coù maøu). Choïn Black
and White neáu ñang söû duïng maøn hình maøu nhöng laïi muoán laøm baûn ñoà chuû ñeà
(xem Chöông XIII) toâ maøu theo cheá ñoä thang maøu xaùm (gray scale). Choïn Color
neáu ñang söû duïng moät maøn hình traéng ñen nhöng laïi muoán in moät baûn ñoà chuû ñeà
coù maøu ra moät maùy in maøu.

- Aspect Ratio Adjustment: tuyø choïn Use custom Screen Size maëc ñònh ñöôïc taét ñi.
Tuyø choïn naøy cho pheùp töï ñieàu chænh laïi kích thöôùc maøn hình sao cho baûn ñoà in ra
coù kích thöôùc phuø hôïp.

- Paper and Layout Units: choïn ñôn vò tính khoaûng caùch treân trang giaáy vaø treân cöûa
8

Hình I.11. Hoäp thoaïi Preferences.
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soå trình baøy. Ta thöôøng
söû duïng cm (centime-
ters). Ñôn vò maëc ñònh laø
Inch (1 inch = 2,54 cm).

- Number of Undo Objects:
thieát laäp soá laàn caùc leänh
chænh söûa coù theå quay
ngöôïc laïi ñöôïc. Tuy
nhieân ta khoâng theå quay
ngöôïc laïi trong nhöõng
leänh sau: Revert, Save,
Save As, Modify Table.
Ta cuõng khoâng theå quay
ngöôïc laïi ñoái vôùi nhöõng
leänh naøo taùc ñoäng leân lôùp
Cosmetic. Thieát laäp maëc
ñònh laø 10 laàn. Ta coù theå
thieát laäp giaù trò töø 0 ñeán
800. Thieát laäp laø 0 seõ huyû
taùc duïng cuûa leänh Undo
treân MapInfo.

- Pre-version 4 Symbols:
tuyø choïn naøy chæ ñònh
caùch veõ caùc bieåu töôïng töø
caùc phieân baûn MapInfo
tröôùc 4.0. Ñaùnh daáu
Display Using True Type
Font ñeå veõ caùc bieåu
töôïng daïng vector baèng
caùc kyù töï töø boä bieåu töôïng
(Symbol Font) cuûa
MapInfo. Taét tuøy choïn naøy ñi neáu muoán veõ caùc bieåu töôïng kieåu vector. Thieát laäp
maëc ñònh laø veõ caùc bieåu töôïng ôû daïng vector.

- Date Window for 2-digit Year: chænh ngaøy cuûa heä ñieàu haønh ñoái vôùi ñònh daïng naêm
coù hai chöõ soá. Xem chi tieát phaàn naøy trong Chöông XVIII, muïc XVIII.2.5.

I.2.2. Map Window

Hoäp thoaïi Map Window (hình I.13) duøng ñeå kieåm soaùt caùc thieát laäp maëc ñònh cho
cöûa soå baûn ñoà naøo trong MapInfo. Moät soá thieát laäp trong phaàn naøy coù theå bò ghi ñeø leân
neáu coù moät cöûa soå baûn ñoà ñang ñöôïc môû vaø caùc thieát laäp ñoù ñöôïc ñieàu chænh laïi trong
leänh Map > Options (xem theâm trong Chöông X, muïc X.1). Nhöõng thieát laäp coù theå bò
ghi ñeø leân bao goàm Caùc ñieàu chænh veà kích thöôùc cöûa soå baûn ñoà, xaùc laäp caùch tính
toaùn veà khoaûng caùch/dieän tích vaø cheá ñoä hieån thò toaï ñoä theo ñoä-phuùt-giaây.

- Highlight Control: cho pheùp ta quy ñònh kieåu ñaùnh daáu caùc vaät theå ñöôøng vaø vuøng
khi chuùng ñöôïc choïn (Selected Objects) vaø khi chuùng ñöôïc thieát laäp laø muïc tieâu
(Target Objects) (xem Chöông V). Cheá ñoä maëc ñònh ñöôïc hieån thò ôû 4 nuùt beân caïnh
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töông öùng cho ñöôøng vaø vuøng. Nhaép chuoät vaøo töøng nuùt ñeå vaøo hoäp thoaïi ñieàu
chænh laïi kieåu ñaùnh daáu vaät theå.

- Warn Prior to Loss of: thieát laäp cheá ñoä hieän hoäp thoaïi caûnh baùo khi ta thöïc hieän ñoùng
hay taét hieån thò moät baûng vaø daãn ñeán vieäc maát caùc vaät theå treân lôùp Cosmetic
(Cosmetic Objects), caùc nhaõn (Map Labels), caùc lôùp baûn ñoà chuû ñeà (Thematic
Layers). Cheá ñoä maëc ñònh laø caû 3 tuyø choïn naøy ñeàu ñöôïc baät leân.

- When Resizing Map Window: coù hai tuyø choïn. Tuyø choïn maëc ñònh laø Fit Map to New
Window. Ñoái vôùi tuyø choïn naøy, khi ñieàu chænh kích thöôùc cöûa soå baûn ñoà thì tyû leä baûn
ñoà töï ñoäng thay ñoåi theo ñeå ñaûm baûo ta nhìn thaáy phaàn baûn ñoà hieån thò nhö luùc tröôùc
khi ñieàu chænh. Tuyø choïn Preserve Current Scale giöõ nguyeân tyû leä baûn ñoà khi thay
ñoåi kích thöôùc cöûa soå baûn ñoà.

- Move Duplicate Nodes in: thieát laäp naøy chæ ñònh MapInfo coù di chuyeån caùc noát choàng
nhau (hay truøng nhau) hay khoâng khi söû duïng leänh chænh söûa hình daïng (Reshape)
ñeå chænh söûa caùc vaät theå naèm saùt nhau, nhö tröôøng hôïp caùc vuøng naèm caïnh nhau.
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Cheá ñoä maëc ñònh laø None of the Layer - khoâng di chuyeån caùc noát choàng. Tuyø choïn
the Same Layer cho pheùp di chuyeån caùc noát choàng ôû trong cuøng lôùp ñang chænh
söûa.

- Apply Clip Region Using: phaàn naøy cho pheùp ta chæ ñònh caét vuøng nhö theá naøo. Coù
3 tuyø choïn:
+ Window Device Clipping (all objects): vieäc caét vuøng ñöôïc kieåm soaùt bôûi trình hieån

thò cuûa heä thoáng. Taát caû caùc vaät theå (keå caû ñieåm, nhaõn, kyù töï, aûnh queùt vaø aûnh
grid) ñeàu bò caét taïi ranh giôùi vuøng caét. Ñaây laø tuyø choïn maëc ñònh.

+ Window Device Clipping (no points, text): phöông phaùp naøy moâ phoûng laïi phöông
phaùp caét vuøng baèng leänh Erase Outside cuûa caùc phieân baûn MapInfo tröôùc ñaây.
Taát caû caùc vaät theå ñeàu bò bò caét khi duøng leänh Erase Outside nhöng caùc ñieåm vaø
nhaõn vaãn coøn laïi. Caùc vaät theå kieåu ñieåm vaø caùc nhaõn seõ hieån thò chæ khi naøo ñieåm
ñoù hay troïng taâm cuûa nhaõn ñoù naèm beân trong vuøng caét. Caùc vaät theå kieåu kyù töï,
caùc taäp tin aûnh vaø aûnh grid khoâng bò caét.

+ Erase Outside (no points, text): phöông phaùp naøy söû duïng chöùc naêng Erase
Outside cuûa MapInfo. Caùch naøy ñöôïc söû duïng cho taát caû caùc phieân baûn tröôùc
MapInfo 6.0. Vaät theå caét vuøng (Clip Region object) chính laø vaät theå caét vaø taát caû
caùc vaät theå khaùc ñeàu laø muïc tieâu cuûa leänh naøy. Taát caû caùc vaät theå ñeàu bò caét
baèng caùch söû duïng cô cheá caét cuûa leänh Erase Outside, ngoaïi tröø caùc ñieåm vaø
nhaõn. Ngoaøi ra caùc ñieåm vaø nhaõn seõ chæ hieån thò neáu ñieåm ñoù hay troïng taâm cuûa
nhaõn naèm trong vuøng caét. Vaät theå kieåu kyù töï, aûnh queùt vaø aûnh grid khoâng bò caét.

- Distance/Area Using: phaàn naøy cho pheùp chæ ñònh caùch tính khoaûng caùch/dieän tích
maø MapInfo söû duïng cho moät cöûa soå baûn ñoà môùi. Cheá ñoä Spherical (theo maët caàu)
laø cheá ñoä maëc ñònh. Caùch tính toaùn theo maët caàu ño khoaûng caùch theo maët cong
cuûa quaû ñaát. Döõ lieäu tröôùc tieân ñöôïc ñoåi thaønh kinh ñoä/vó ñoä roài sau ñoù pheùp tính
môùi ñöôïc thöïc hieän. Caùc baûn ñoà daïng kinh ñoä/vó ñoä luoân luoân söû duïng phöông phaùp
tính theo maët caàu. Tuyø choïn Cartesian laø phöông phaùp tính toaùn theo heä toaï ñoä
Descartes. Trong phöông phaùp naøy caùc tính toaùn ñöôïc thöïc hieän döïa treân söï quy
chieáu döõ lieäu veà moät maët phaúng. Heä toaï ñoä Descartes (heä toaï ñoä x, y) ñònh nghóa
vò trí cuûa moät ñieåm trong khoâng gian hai chieàu baèng pheùp chieáu vuoâng goùc leân hai
truïc x vaø y vuoâng goùc nhau. Caùc heä quy chieáu söû duïng kinh ñoä/vó ñoä khoâng theå tính
toaùn theo heä Descartes ñöôïc.

Ñeå chæ ñònh phöông phaùp tính toaùn cho moät cöûa soå baûn ñoà ñang ñöôïc môû, duøng
leänh Map > Options (xem theâm Chöông X).

- Metric Distance and Area Units: ñaùnh daáu tuyø choïn naøy seõ ñoåi ñôn vò tính toaùn veà
heä meùt, töùc laø tính khoaûng caùch baèng kilomet vaø tính dieän tích baèng kilomet vuoâng.
Theo maëc ñònh tuyø choïn naøy ñöôïc taét ñi vaø luùc ñoù khoaûng caùch ñöôïc tính baèng daëm
(mile - 1 mile = 1,61 km) vaø dieän tích ñöôïc tính baèng daëm vuoâng (1 daëm vuoâng =
2,5921 km vuoâng).

- Scroll Bar: theo cheá ñoä maëc ñònh, treân cöûa soå baûn ñoà khoâng coù hai thanh cuoän
ngang vaø ñöùng. Ñaùnh daáu tuyø choïn naøy neáu muoán hieån thò thanh cuoän ngang vaø
ñöùng treân cöûa soå baûn ñoà.

- Show InfoTips: theo maëc ñònh tuyø choïn naøy ñöôïc baät leân (hieån thò
thoâng tin taïi vò trí con troû chuoät khi di chuyeån chuoät ñeán moät vò trí naøo
ñoù).
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- Show Coordinates in Degrees - Minutes - Seconds: maëc ñònh tuyø choïn naøy ñöôïc taét
ñi, luùc ñoù MapInfo hieån thò toaï ñoä theo ñoä thaäp phaân. Neáu ñaùnh daáu tuyø choïn naøy
thì MapInfo seõ hieån thò toaï ñoä theo ñoä-phuùt-giaây. Ta cuõng coù theå chænh söûa toaï ñoä
baèng caùch naïp giaù trò theo ñoä - phuùt - giaây treân lôùp baûn ñoà ñang ôû cheá ñoä chænh söûa.
Thieát laäp naøy coù theå bò ghi ñeø neáu ta thieát laäp laïi cheá ñoä hieån thò cho moät cöûa soå baûn
ñoà hieän haønh baèng leänh Map > Options.

- Enable Hardware Acceleration for 3D Map Window: maëc ñònh tuyø choïn naøy ñöôïc baät
leân. Tuyø choïn naøy ñöôïc baät seõ khieán cho MapInfo söû duïng tính naêng cuûa card ñoà
hoaï treân maùy tính ñeå hieån thò baûn ñoà 3D (ba chieàu). Taét tuyø choïn naøy ñi seõ laøm giaûm
khaû naêng xöû lyù ba chieàu tuy nhieân noù coù theå ngaên ngöøa truïc traëc ñoái vôùi moät soá card
ñoà hoaï vaø trình ñieàu khieån card ñoà hoaï khoâng töông thích.

- Snap Tolerance: thieát laäp khoaûng caùch “caén ñieåm” tính theo pixel (ñieåm aûnh) khi cheá
ñoä SNAP ñöôïc kích hoaït (baèng caùch nhaán phím S). Thieát laäp maëc ñònh laø 5 pixel.

- Handler for New Grids: choïn ñònh daïng xuaát taäp tin aûnh grid. Theo maëc ñònh trình
quaûn lyù taäp tin grid cuûa MapInfo ñöôïc choïn (töùc xuaát taäp tin grid ra ñònh daïng .mig).
Caùc loaïi ñònh daïng taäp tin grid coù trong danh saùch naøy tuyø thuoäc vaøo caùc trình quaûn
lyù taäp tin grid naøo ñöôïc caøi ñaët treân MapInfo.

I.2.3. Legend Window

Phaàn naøy cho pheùp ñieàu chænh caùc thieát laäp maëc ñònh cho kieåu chöõ cuûa chuù giaûi
trong cöûa soå chuù giaûi. Hoäp thoaïi naøy (hình I.14) töông töï nhö hoäp thoaïi trong böôùc 2
cuûa leänh Map > Create Legend (xem Chöông XIII, muïc XIII.1.2.2).

OÂ Title Pattern cho pheùp chænh kieåu chöõ cuûa tieâu ñeà chuù giaûi, oâ Subtitle Pattern ñeå
chænh kieåu chöõ cuûa tieâu ñeà phuï, Style Name Pattern ñeå chænh kieåu chöõ cuûa noäi dung
chuù giaûi vaø Border neáu ñöôïc ñaùnh daáu cho pheùp ta ñònh daïng ñöôøng vieàn cuûa khung
chuù giaûi.

Trong hoäp thoaïi naøy daáu thaêng (#) töôïng tröng cho teân cuûa baûng ñöôïc laøm chuù giaûi.
Ví duï neáu ta laøm chuù giaûi cho baûng ban_do thì tieâu ñeà chuù giaûi seõ laø ban_do Legend.
ta coù theå thay ñoåi tieâu ñeà naøy trong quaù trình laøm chuù giaûi cho phuø hôïp. Daáu phaàn traêm
(%) töôïng tröng cho kieåu cuûa bieåu töôïng ñöôïc laøm chuù giaûi, ví duï nhö point (ñieåm), line
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(ñöôøng) hay region (vuøng). Ví duï neáu ta laøm chuù giaûi cho baûn ñoà cac_tinh laø moät baûng
kieåu vuøng thì choã kyù töï % seõ laø Region.

Tuy nhieân ñoái vôùi caùc baûn ñoà baèng tieáng Vieät thì trong haàu heát caùc tröôøng hôïp ta
ñeàu phaûi ñieàu chænh caùc phaàn naøy, ngoaïi tröø phaàn kieåu chöõ cho chuù giaûi ta coù theå chænh
laïi kieåu chöõ tieáng Vieät tröôùc trong phaàn naøy.

I.2.4. StartUp

Phaàn naøy cho pheùp kieåm
soaùt cheá ñoä khôûi ñoäng cuûa
MapInfo, töùc kieåm soaùt taäp tin
workspace coù teân MAPIN-
FOW.WOR, cuõng nhö cho
pheùp xaùc laäp caùc thoâng tin veà
maùy in vaø query (pheùp truy
vaán) coù ñöôïc löu vaøo caùc taäp
tin workspace hay khoâng.
Hoäp thoaïi Startup
Preferences ñöôïc trình baøy
treân hình I.15.

- Taäp tin MAPINFOW.WOR:
tuyø choïn Save MAPIN-
FOW.WOR when Existing
MapInfo ñöôïc baät leân seõ töï
ñoäng löu laïi cheá ñoä laøm vieäc cuûa ta vaøo taäp tin workspace coù teân laø
MAPINFOW.WOR khi thoaùt khoûi MapInfo vaø hieån thò laïi thieát laäp naøy khi khôûi ñoäng
laïi MapInfo. Ñeå löu taäp tin MAPINFOW.WOR, ñaùnh daáu choïn vaøo oâ naøy. Ñeå hieån thò
taäp tin naøy khi khôûi ñoäng MapInfo, ñaùnh daáu choïn vaøo oâ Load MAPINFOW.WOR
when Starting MapInfo. Tuyø choïn naøy chæ hieän leân khi taét choïn trong oâ Display Quick
Start ôû döôùi.

- Save Queries in Workspaces: ñaùnh daáu tuyø choïn naøy thì nhöõng pheùp truy vaán
(query) baèng leänh SQL Select do ta thöïc hieän trong moät phieân laøm vieäc seõ ñöôïc löu
vaøo taäp tin workspace.

- Printer Information: tuyø choïn Save Printer Information into Workspaces cho pheùp löu
thoâng tin veà maùy in vaøo taäp tin workspace (nhö teân maùy in, ñònh höôùng trang giaáy,
khoå giaáy vaø soá baûn in). Caùc thieát laäp naøy bao goàm caû nhöõng thieát laäp bò ghi ñeø leân
bôûi caùc thieát laäp veà maùy in trong phaàn Printers. Tuyø choïn Restore Printer Information
from workspaces cho pheùp ta phuïc hoài laïi caùc thieát laäp maùy in treân khi môû taäp tin
workspace ra.

Löu yù raèng caùc tuyø choïn veà maùy in naøy chæ ñöôïc löu trong taäp tin workspace
cuûa phieân baûn MapInfo 6.0. Ñöøng ñaùnh daáu hai tuyø choïn naøy neáu coù yù ñònh söû duïng
taäp tin workspace treân moät phieân baûn MapInfo cuõ hôn vì coù khaû naêng seõ khoâng môû
ñöôïc taäp tin ñoù.

- Display Quick Start Dialog: ñaùnh daáu tuyø choïn naøy seõ khieán cho hoäp thoaïi Quick
Start Dialog (khôûi ñoäng nhanh) môû ra khi khôûi ñoäng MapInfo.
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I.2.5. Address Matching
Caùc thieát laäp naøy lieân quan ñeán caùc baûn ñoà soá thöông maïi cuûa MapInfo coù ñòa chæ

treân caùc lôùp ñöôøng giao thoâng. Haàu nhö ta khoâng söû duïng tính naêng naøy.

I.2.6. Directories

Caùc thieát laäp trong phaàn naøy cho pheùp chæ ñònh caùch tìm kieám caùc taäp tin töông öùng
trong nhöõng thö muïc naøo. Töông öùng vôi caùc haøng treân hoäp thoaïi naøy laø caùc loaïi taäp
tin maø ta coù theå thieát laäp thö muïc maëc ñònh cho chuùng. Ñoù laø: Tables (caùc baûng),
Workspaces (caùc taäp tin workspace), MapBasic Programs (caùc chöông trình MapBasic),
Import files (caùc taäp tin ñeå nhaäp vaøo MapInfo), DBMS SQL Queries (caùc pheùp choïn
SQL treân DBMS), Theme templates (caùc maãu baûn chuû ñeà), Saved queries (caùc query
ñaõ ñöôïc löu laïi), New Grids (caùc taäp tin aûnh grid môùi taïo), Crystal Report files (caùc taäp
tin baùo caùo Crystal), Graph support files (caùc taäp tin hoã trôï bieåu ñoà) (hình I.16).

Ñeå choïn thö muïc maëc ñònh cho moät loaïi taäp tin naøo ñoù, ta nhaép chuoät choïn haøng
töông öùng trong hoäp thoaïi Initial Directories for File Dialogs, sau ñoù nhaép chuoät vaøo nuùt
Modify phía döôùi. Moät hoäp thoaïi Choose Directory (choïn Thö muïc) môû ra cho pheùp ta
ñoåi teân thö muïc trong hoäp thoaïi naøy. Ví duï ta löu caùc lôùp baûn ñoà trong oå ñóa D, thö muïc
BANDO. Ñeå thieát laäp ñoù laø thö muïc maëc ñònh cho caùc baûng ta seõ choïn haøng Tables
trong hoäp thoaïi Directory Preferences roài nhaép chuoät vaøo nuùt Modify. Hoäp thoaïi Choose
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Directory môû ra. Trong oâ Drive choïn oå ñóa D:\, danh saùch caùc thö muïc cuûa oå ñóa naøy
hieän leân ôû phía treân, choïn thö muïc BANDO roài choïn OK. Laàn sau moãi khi choïn leänh môû
baûng ta vaøo ngay thö muïc naøy.

I.2.7. Output Settings

Phaàn naøy cho pheùp thieát
laäp cheá ñoä maøu cho caùc aûnh
queùt vaø aûnh grid hieån thò
treân maøn hình, khi in ra hay
khi xuaát ra taäp tin aûnh.
Ngoaøi ra ta cuõng coù theå chæ
ñònh vieäc kieåm soaùt ñoä trong
suoát (transparency) cuûa caùc
taäp tin aûnh vaø taäp tin kieåu
vector treân caû baûn in ra laãn
aûnh ñöôïc xuaát ra.

Ta cuõng coù theå ghi ñeø
leân caùc thieát laäp trong hoäp
thoaïi naøy baèng caùc ñieàu
chænh trong hoäp thoaïi
Advanced Printing. Hoäp
thoaïi Output Settings (hình
I.17) bao goàm caùc phaàn
sau:
- Display: phaàn naøy quy

ñònh cheá ñoä aûnh queùt vaø
aûnh grid hieån thò treân
maøn hình. Ñaùnh daáu
choïn vaøo oâ Display
Raster In True Color
When Possible ñeå hieån
thò aûnh queùt vaø aûnh grid
ôû cheá ñoä 24 bit maøu. Tuyø
choïn naøy coù theå thöïc
hieän ñöôïc khi aûnh ôû cheá
ñoä 24 bit maøu vaø maøn
hình coù treân 256 maøu. Phaàn Dither Method cho pheùp choïn moät phöông phaùp hieån
thò maøu khaùc khi khoâng theå hieån thò aûnh ôû cheá ñoä maøu thöïc (true color). Ta coù theå
choïn phöông phaùp thay theá laø Halftone hay Error Diffusion. Caùc phöông phaùp naøy
seõ ñöôïc söû duïng trong tröôøng hôïp moät aûnh 24 bit maøu phaûi ñoåi thaønh 256 maøu.
Ñieàu naøy xaûy ra khi môû moät aûnh ôû cheá ñoä 24 bit maøu nhöng maøn hình laïi coù döôùi
256 maøu.

- Printing: Caùc tuyø choïn trong phaàn Output Method cho pheùp choïn in baûn ñoà vaø trang
Layout baèng phöông phaùp caùc phieân baûn MapInfo tröôùc ñaây söû duïng (Print Directly
to Device - In tröïc tieáp ra maùy in) hay söû duïng phöông phaùp in môùi laø Enhanced
Metafile (Print Using Enhanced Metafile). Trong phöông phaùp in môùi naøy MapInfo
taïo ra moät metafile coù chöùa noäi dung in vaø göûi taäp tin enhanced metafile ñoù ñeán maùy

15

Hình I.17. Hoäp thoaïi Output Preferences.

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com


in. Tuyø choïn naøy coù theå cho keát quaû in toát hôn nhieàu maø khoâng laøm maát chaát löôïng
baûn ñoà, tuy nhieân maùy in phaûi ñuû maïnh ñeå chöùa ñöôïc taäp tin metafile ñoù.

Trong phaàn Printing coù moät soá tuyø choïn nöõa, ñoù laø:
- Print Border for Map Window: ñaùnh daáu tuyø choïn naøy seõ taïo ra moät khung vieàn ñen

quanh trang in.

- Internal Handling for Transparent Raster: neáu ñaùnh daáu tuyø choïn naøy MapInfo seõ töï
quaûn lyù ñoä trong suoát cuûa cuûa caùc aûnh queùt vaø aûnh grid. Boû choïn oâ naøy seõ ñeå cho
maùy in quaûn lyù tính chaát naøy cuûa aûnh. Ta neân baät tuyø choïn naøy leân vì nhieàu maùy in
khoâng theå quaûn lyù toát tính chaát trong suoát cuûa aûnh.

- Print Raster in True Color When Possible: tuyø choïn naøy töông töï nhö trong phaàn
Display Settings ôû treân, chæ coù ñieàu noù aùp duïng cho phaàn in ra trang giaáy. Ñaùnh daáu
tuyø choïn naøy ñeå in aûnh queùt hay aûnh grid ôû cheá ñoä 24 bit maøu, neáu ñöôïc. Ta cuõng
caàn choïn moät phöông phaùp hieån thò maøu thay theá trong oâ döôùi. Coù hai tuyø choïn laø
Halftone vaø Error Diffusion. Phöông phaùp naøo ñöôïc choïn seõ ñöôïc söû duïng khi aûnh
khoâng theå in ra cheá ñoä 24 bit maøu ñöôïc.

- Window Export Settings: Caùc tuyø choïn trong phaàn naøy hoaøn toaøn gioáng vôùi caùc tuyø
choïn trong phaàn Printing ôû treân chæ coù ñieàu noù aùp duïng cho aûnh xuaát ra. Caùc thieát
laäp trong phaàn naøy ñöôïc söû duïng trong hoäp thoaïi Advanced Export Window Options
(leänh File > Save Window As > Advanced). Neáu muoán thay ñoåi nhöõng tuyø choïn
trong phaàn naøy thì nhaép chuoät choïn nuùt Advanced khi thöïc hieän leänh Save Window
As vaø chænh laïi thieát laäp theo yù muoán.

II.2.8. Printer

Hoäp thoaïi Printer
Preferences (hình I.18) cho
pheùp choïn maùy in cho
MapInfo. Neáu ñaùnh daáu tuyø
choïn Window Default thì
MapInfo seõ söû duïng maùy in
maëc ñònh cuûa heä ñieàu haønh.
Tuy nhieân trong tröôøng hôïp
caøi ñaët nhieàu maùy in ta coù
theå choïn maùy in rieâng cho
MapInfo neáu ñaùnh daáu choïn
trong oâ MapInfo Preferred vaø
choïn loaïi maùy in trong oâ
Name ôû döôùi. Status cho bieát
tình traïng cuûa maùy in (coù
saün saøng in ñöôïc hay
khoâng). Type cho bieát teân
maùy in. Where cho bieát maùy
in ñang ñöôïc gaén ôû coång
naøo treân maùy tính. OÂ Size ñeå
choïn khoå giaáy. Phaàn
Orientation cho pheùp ñònh
daïng trang in theo chieàu
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ñöùng (Portrait) hay theo chieàu ngang (Landscape).

Nuùt Network ôû döôùi cho pheùp choïn maùy in treân maïng neáu ta coù thieát laäp moät maïng
noäi boä.
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